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Preface 

 
Microsoft Excel is the world's most used business intelligence tool. Its 
knowledge is even compulsory for an MBA degree and the business 
world depends greatly on it.  
 
This book is aimed at making you very good in Microsoft Excel for 
business data analysis, teaching you with companion videos and 
practice files that can be accessed at www.urbizedge.com/about 
(bottom of the page). It's intended for Sales Managers, Financial 
Analysts, Business Analysts, Data Analysts, MIS Analysts, HR 
Executives and frequent Excel users.  
 
It is written by Michael Olafusi a three time Microsoft Excel MVP 
(most valuable professional) and a full-time Microsoft Excel 
consultant. He is the founder of UrBizEdge, a business data analysis 
and Microsoft Excel consulting firm. He has trained hundreds of 
business professionals on Microsoft Excel and has used the experience 
gained from interacting with them both during such trainings and 
while consulting for companies to write this excellent guide for the 
busy professional who needs the improved work productivity 
Microsoft Excel provides. 
 
This book is constantly being updated to cover the new features in 
new versions of Excel and if you purchase the kindle version you can 
always re-download the updated copy. Just check the book listing 
page (http://www.amazon.com/gp/product/B01255TQ84) for 
updates and re-download if a newer version has been published. All 
at no cost to you. It is the best way to give you value for your money 
without forcing you to buy different editions of the same book. If you 
feel any part of this book can be better improved or expanded, 
please send an email to mike@urbizedge.com  

http://www.urbizedge.com/about
http://www.amazon.com/gp/product/B01255TQ84
mailto:mike@urbizedge.com
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Microsoft Excel: It’s more powerful 
and easier to use than you think! 

 

 

 

 

 
We’ve got Home menu, Insert menu, Page Layout menu, Formulas 
menu, Data menu, Review menu and View menu. Each of these 
menus will be discussed in practical terms. 
 
The other menus — Developer menu, Load Test Menu and Power 
Query menu — are not displayed by default. I enabled them as I do a 
lot of programming and other advanced stuff in Excel which I need 
them for. 
 

Home Menu 

 
The home menu is Excel’s most used menu. It has very 
straightforward sub-menus. 
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Clipboard: Allows you to copy, cut and paste in Excel 
Font: Allows you to set font size, color, background color (fill) & turn 
on bold or italics or underline. 
Alignment: Allows you to set the position of whatever you’ve typed 
(or copied) into Excel. It also allows you to set how it’s written: 
horizontal, vertical or slanting. 
Number: Allows you to set how a number is shown in Excel: regular 
number, currency, scientific, percentage, fraction…  
Styles: Allows you to set the format of an Excel cell based on the 
data it holds (conditional formatting). It also allows you to convert a 
selection of cells to table, and to set quick formats for a cell. 
Cells: Allows you to insert new cells, delete cells and change cell 
format. 
Editing: It houses the very useful Sort and filter tools. And also Find 
& Select, Find & Replace. There’s also AutoSum which helps you sum 
all numbers in a selection. 
 
 

Insert Menu 

 
The Insert menu houses some of Excel’s best tools. 
 

 
 
Tables: Allows you to insert PivotTable, PivotChart and Table. 
Inserting a table in Excel allows for quick formatting, and better 
formulas (via named ranges). PivotTable and PivotChart will be 
discussed later. 
Illustrations: Allows you to insert images and shapes. 
Charts: Allows you to insert charts, which will be specially discussed 
later. 
Tours: Houses Map which takes you straight to Power Map. Power 
Map is part of Microsoft’s new Power BI. It enables you make geo-
maps and create amazing data visualization tours. 
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Reports: Lets you access Power View, another Power BI tool. Power 
View allows to create a data model, loading up many different 
databases and creating analysis that cuts across all the databases, 
allowing you to see insights that are beyond a single database. 
Sparklines: Allows you to insert charts that fit into one Excel cell. 
They make some reports beautiful and easy to read. 
Filter: Allows you to filter out field values you are not interested in. 
Links: Allows you point a cell content to a website or an email 
address. 
Text: Allows you to insert texts and objects (pretty much anything, 
including a PDF document) 
Symbols: Allows you to type out equations and special symbols. 
 
 

Page Layout Menu 

 
The Page Layout menu does just that: setting up your Excel 
document’s page look and for printing. 
 

 
 
Themes: It’s not often used; it sets the look of the Excel window 
itself.  
Page Setup: It allows you to set how the page comes out when 
printed. Most used are the Orientation (to set as Portrait or 
Landscape) and Print Area (to select on the cells you want to print). 
Scale to Fit: It allows you to set how much is printed per page. Most 
frequent use is to force Excel to print on one page, or fit all the 
fields (columns) on one page width. 
Sheet Options: You wouldn’t want to change the default. It allows 
you set whether Excel gridlines be printed or not, and headings too. 
Default is no/off (unticked). 
Arrange: It lets you rearrange overlapping objects (shapes, images, 
textboxes…). Or align them. 
 
 

Formulas Menu 

 
The Formulas menu gives you access to Excel’s built-in formulas. 
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Function Library: It has the formulas grouped by category. Once you 
have an idea of what you want done, it helps you locate the formula 
to use. It’s good to look through it once in a while to have an idea of 
the out-of-the-box analysis Excel can do. 
Defined Names: Lets you name a cell or selection of cells. Can be 
very useful when analyzing a big database or building a model. 
Formula Auditing: Allows you to check for errors in your formulas, 
trace formula cells and see how your final result is being calculated. 
Calculation: Allows you to set when the formulas in your Excel sheet 
are calculated: automatic (whenever a cell value changes) or manual 
(at first entry and when you force them to be recalculated). 
 

Data Menu 

 
The Data menu allows you to work with external data and do basic 
data formatting. 
 

 
 
Get External Data: It allows you to import or link to an external data 
file (non-Excel file). You’ll use it whenever you have a data in text 
file and need it worked on in Excel. 
Connections: Allows you to make changes to the connections/links to 
an external data file. Or force a refresh of the connections to capture 
changes made in the external data file since last connection. 
Sort & Filter: Allows you to sort data and do some filtering too. Filter 
allows you to specify values to display. 
Data Tools: Allows you do very basic data analysis. Especially 
removing duplicate entries, and splitting one field into several (text-
to-columns). Example is splitting full name into first name and last 
name. 
Outline: Allows you to group (and hide) several rows. Useful for large 
data reports with few categories; helps to group categories. 
Analysis: This is only visible after you enable Data Analysis add-in or 
Solver add-in. It allows you access a large collection of statistical 
analysis tools and modeling. 
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Review Menu 

 
The Review menu is for spell checks, commenting and setting access 
restrictions. 
 

 
 
Proofing: Allows you to carry out spell checks and word meaning 
checks. 
Language: Allows you to translate the Excel file content from one 
language to another. 
Comments: Allows you to include comments in an Excel sheet, view 
all comments at once or delete comments. 
Changes: Allows you to set access restrictions and track changes to 
the Excel file. Also allows you to share the file. 
 

View Menu 

 
The View menu allows you to change the window layout of the Excel 
document. It doesn’t change anything in the actual document, just 
the way it’s displayed. 
 

 
 
Workbook views: Allows you to set how the workbook (Excel file) is 
displayed. 
Show: Controls what non-printing details are shown: Gridlines, 
Headings, Formula bar and Ruler. The one you’ll be interested most 
in is Gridlines. If you want your Excel sheet to look more like a Word 
file, untick the Gridlines. That’s what’s done to every Excel sheet 
you see that has no Gridlines. 
Zoom: Does what it says: sets zoom. 
Window: Allows you to freeze headers so when you scroll they will 
never be out of view. And also allows you to split the Excel sheet 
display, so you can compare two different parts of the sheet. 
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Macros: Allows you to see the macros programmed in the Excel file 
(if there’s any macro in it). Shows only when the developer menu is 
enabled. 
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How Excel Handles What You Type 

 
In Excel, you type into small rectangular boxes called cells. I would 
be referring to everything you type or copy into Excel cells as Data.  
 
Every cell has an address, because each cell is an intersection of a 
row and a column. The cell selected in the image below, is addressed 
as cell A1. It is the intersection of column A and row 1. A collection 
of millions of these cells make an Excel sheet. And an Excel file (also 
referred to as Excel workbook) is a collection of one or more Excel 
sheets. 
 

 
 
Sometimes, what you type into a cell takes more space than the cell 
has. Don’t worry, just expand the column width by dragging the right 
border of the column header. 
 
Like this: 
 



 

 
 

12 

 
 
 

Different Data Types in Excel 
 
Excel recognizes 4 different data types: Text, Number, Boolean & 
Formula. Anything you type into Excel will fall under one of these. 
 
Text: Whenever you type alphabets, or a mix of alphabets and 
numbers into Excel (without proceeding with =), everything is 
recognized as text. By default, Excel aligns text to the left of the 
cell. 
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Number: If all you type into a cell are digits, they are recognized as 
Number by Excel. By default, Excel aligns number to the right. 
 

 
 
Boolean: FALSE and TRUE are Boolean entries. You’ll hardly use 
them. They are used for setting up complex formulas. By default, 
whenever you type false or true in a cell, Excel will put it in upper 
case and align it to the center. 
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Formula: Once you begin a cell entry with =, Excel treats everything 
you type after as a formula.  
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As a recap, see the image below. 
 

 
 
 
The practical importance of this is that if you receive a sales report 
in Excel and the numbers are aligned to left instead of right you 
should be concerned. There are three reasons this can happen and 
two of those reasons will cause some of your mathematical formulas 
to not work correctly. You wouldn’t want to do an incorrect analysis, 
so it’s best to check why the numbers are aligned to the left and not 
to the right as expected. 
 

1. It could be that the author forced the numbers to align to the 
left. To find out if that’s the reason, check the alignment under 
Home menu. 
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2. It could be that the author forced the number to be treated 
as text by setting the cell format to text 
 

 
 

3. It could be that the author preceded the number with a 
single apostrophe (’) before typing the number. This is a trick savvy 
users use to force Excel to keep the zeros at the beginning of your 
phone number or bank account number. Unfortunately, it forces 
Excel to treat the cell entry as a text and align it to the left. 
 

 
 
Out of these three ways of making a number show as aligned to the 
left, only the first one leaves the number intact. The other ways 
transform the number to text and will give you issues when you 
include them in calculations that normally would work on numbers. 
 
Now you have an idea of how useful an understanding of the default 
ways Excel treat the different data types can be in your day to day 
use of Excel. 
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Data Consistency, starting with the end in 
view 

Excel is different from every other Microsoft Office program you use. 
Most of the documents, reports and analysis you do with Excel will be 
used some day in the future for another report or analysis. 
 
To become an expert in Excel, you have to always work with the end 
in mind. You have to create your Excel documents in such a way that 
you can easily use them for some bigger reports in the future. And 
there are some general rules I'll recommend you work with to achieve 
this. 
 
1. Always use a compact table structure for entering you core data in 
Excel. This means using the minimum number of rows and minimum 
number of columns. Example of a compact table and non-compact 
table is shown below: 
 

 
 
Same table but not compact, shown below. 
 



 

 
 

18 

 
 
In the non-compact table example, you can delete rows 37 and 38 
without deleting any data in the table. 
 
2. Use descriptive names for your column headers and row headers. 
Be as descriptive as possible in naming the fields in your table, make 
it easy for anyone who will view your table to understand the 
information it convenes. 
 
Below is a table with field names that are descriptive enough for 
anyone to understand the information the table convenes. 
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Below is a table that has headers that are not descriptive enough. It’s 
hard to figure out the specific information in the table. Is it a table 
of revenue or expense? Are the companies clients or suppliers? What 
year do the months represent — January 2014 or January 2015? 
Whomever you send this report to will call you back for a detailed 
explanation of what you intended to report. 
 

 
 
3. Name your Excel sheets 
Don’t just go ahead with the default names — Sheet1, Sheet2, … — 
rename the sheets to reflect the contents of the sheet. This makes 
your work better organized and future use more convenient. 
 

 
 
To rename a sheet, right click on the sheet name (the default names 
are Sheet1, Sheet2, …) and select rename. And as you see above, you 
can change the color from the default too.  
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4. Also use descriptive names when renaming the Excel sheets. 
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5. Avoid putting too many tables in one Excel sheet. Best to keep just 
related tables in the same sheet if you must put more than one table 
in the sheet. It makes naming the sheet easy and straightforward. 
 
6. Use same naming conventions and table structure across all similar 
Excel files, especially weekly, monthly and yearly reports of the same 
data. 
 
7.  Don’t use CAPS excessively. It makes your reports very 
unprofessional. 
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Building Datasheets that can easily scale 

 
Occasionally, you will have to work on a table whose data grows 
continually. We can refer to such tables as datatables. All tables hold 
data and can technically be referred to as a datatable, but in this 
book we will refer to all tables as just tables and limit the term 
datatable to only tables that grow perpetually.  
 
An example of such a table is an Employee Record table. As long as 
the company exists the table will keep growing and even if the 
company aims to not have over a 100 employees, there will always be 
old employees leaving and new ones taken to replace them. And they 
all have to be captured in the employee record table, no employee’s 
record is deleted when he leaves, there’s only a field added to 
capture his resignation. 
 
There are some peculiar ways of treating a datatable. 
 
1. Have only one datatable on a sheet. Since a datatable is a table 
you expect to grow over time, having only one on a sheet lets you 
have access to all the rows and the columns in the Excel sheet. 
 

 
 

2. Start a datatable as close to cell A1 as possible. Again, this is to 
afford you the maximum space in the sheet for your growing table. 
 
3. Avoid meaningless gaps in the datatable. Make it as compact as 
possible. 
 
4. Arrange the fields such that the most important or basic fields 
come first. For example, in an Employee record table, name should 
come before contact address. 
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5. Have a field for every meaningful chunk of data. It is better to 
have separate fields for first name and last name than have one field 
hold both. 
 
6. Avoid merging cells in a datatable. It is better to repeat cell 
entries than merge the cells. Merged cells aren’t formula friendly. 
 
And as a bonus, avoid hiding rows and columns in the datatable. This 
will save you a lot of future headaches. 
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Sorting 

Sorting is one of the most frequent task we do in Excel. Sorting lets 
you re-arrange data in alphabetical order, lowest to highest, highest 
to lowest, and even by cell color. 
 
We are used to having data arranged in a particular order — A to Z, 
January to December, 1 to 10, and so on. 
 
Below is an example of a table that has its records haphazardly 
arranged. The states are not arranged alphabetically and the months 
are not in the natural order. 
 

 
 
First, let’s have the data sorted by State alphabetically  
 
Below are the recommended steps to sorting a table. Select the 
table, go to the Home menu and click on Sort & Filter. 
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The sorting dialog box comes up. 
 

 
 
This dialog box allows you to add more than the default one level of 
sorting.  
 
Select “State” in the Sort by box and A to Z in the Order box. 
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The result is shown below. 
 

 
 
You can add an extra level of sorting in the sorting dialog box. This 
would be useful in sorting tables like a national population census 
table. You might want to sort first by state (from Abia to Zamfara) 
and then an extra level of sorting by Local Government Areas. So 
you’ll have a setting similar to the one below 
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Next is to sort the months in the natural order we are used to — Jan 
to Dec. This will require a type of sorting called “Left to Right” as 
against the one we just did, called “Top to Bottom”. 
 
So to get this done, we select the table starting from the first month 
to the last month. We will leave the state field out because we want 
it to remain in the position it is. 
 

 
 
Then select the row the months are on (Row 2) and set the order to 
Oldest to Newest. 
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Below is the result. 
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Filtering 

 
Filter is one of the Excel power user’s most used tool. It allows you 
selectively choose what you want to view in a table and hide the 
rest. 
 
It is very easy to access and can be accessed from three different 
places in Excel. 
 
By right clicking and selecting Filter. 
 

 
 
From the Home menu, clicking on Sort & Filter at the right. 
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From the Data menu. 
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Once you’ve turned on the Filter tool by clicking on it, you will see a 
dropdown box beside the headers of the table. 
 

 
 
Clicking on the dropdown box shows you all the unique items in that 
field and you can select the ones you want to view (hiding the rest). 
By default, all items are selected so you will have to unselect the 
ones you don’t want to see. 
 
In the screenshot below, all the pizza items were unselected except 
the BBQ Chicken (meaning only BBQ Chicken was selected). 
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Notice the blue row numbers, it is Excel’s way of visually hinting you 
that some rows have been hidden as they did not contain the items 
we want to view. 
 
Filtering is that simple and straight forward. 
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Advanced Filtering 

Every time you apply filter to a dataset in Excel and then copy out 
the filtered data, you could have saved yourself time and some 
mouse-strokes by using advanced filter. And despite the name, 
advanced filter, it is surprisingly easy to use. 

As an example, I have the fictitious sales record for Dhormino's Pizza 
for June 5, 2016. They sell 16 Pizza types: Meatzaa, Extravaganza 
, BBQ Chicken, Hot Veggie, BBQ Philly Steak, Chicken Feast, Chicken 
Suya, Chicken Legend, Beef Suya, Margarita, Italiano, Pepperoni 
Suya, Veggie Supreme, Hot Pepperoni Feast, Chicken 
Bali and Pepperoni Feast. 
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35 

 

They got a new country manager this March, and one of his strategies 
is to have four brand managers owning 4 different baskets of the 
pizza types, like the FMCG companies do. Two of those managers are 
Michael and Mary. They are to ensure that the brands (pizza types) 
they own are performing well. They are given the latitude and 
resources to promote them using whatever promotional mix they 
want.  

As the company's main business data analyst, you pull out daily sales 
records and extract the ones for each brand manager. With advanced 
filter, it will be a piece of cake. You might even hook it to a recorded 
macro and at a click of button all is done. 

Continuing with the example, let's see how to extract for Michael and 
Mary. 

 
 

Step 1 is to write out the pizza types Michael and Mary manage, 
separately. And to help advanced filter know where to look for those 
pizza names, give them a header that matches that in the sales 
table. See the screenshot above for what I mean. 
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Step 2 is to go to Michael's sheet (another Excel sheet where you 
want to put Michael's). Launch advanced filter from there. It is under 
Data menu, about the middle of the menu tools. 

 
 

Set it to "Copy to another location" 
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Provide the sales data range as the "list range", and Michael's pizza 
types with the header as the "Criteria range". 
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Finally, for the "Copy to", go to Michael's sheet and select where the 
result should be displayed. In this example, I select cell A1. 
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And voila! We get the results. 
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Very easy and cool. 
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And there is more to advanced filter. How about if we have a more 
detailed sales transaction data that captures sales value for each 
sales transaction, and we would like to extract sales transactions that 
generated more that 15,000 naira. That too is very easy with 
advanced filter. 

Just follow me. Below is the snapshot of the detailed sales 
transaction data. 

 
 

We have specified that we want greater than 15,000 naira 
transactions only. 

The steps are just like previous ones. Launch the advanced filter and 
provide both the "List range" and "Criteria range" 
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Specify where the results should be displayed. 
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And voila, again! It's done! 
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Now you should be an expert, like me, at using advanced filter.  
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Excel Errors 

If you've used Excel consistently at work for a few months, you will 
be familiar with some errors Excel displays when it can't get you the 
answer you want. Oftentimes, we don't give some thoughts to these 
errors but the truth is they are not random or meaningless, they are 
trying to tell you something important. 

Today, I will be sharing with you how to interpret those errors and 
uncover the gem in them. How to read the message they are trying to 
pass across to you. 

There are eight error types in Excel: 

1. #VALUE! 

2. #DIV/0! 

3. #N/A 

4. ######## 

5. #NAME? 

6. #REF! 

7. #NUM! 

8. #NULL! 

#VALUE! Error 

You get #VALUE! error when you do a calculation in Excel that doesn't 
make sense. Like Michael + 2. What is Michael + 2? Is Michael a 
number? What kind of answer are you expecting? Can you try it on 
your CASIO calculator?  
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To be blunt, #VALUE! is Excel's way of saying someone is stupid. 
Someone has typed in a calculation that makes absolutely no sense.  

#DIV/0! Error 

As the name implies, division by zero, #DIV/0! is the error you get 
when you do any formula that divides a number by zero. 
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Now, I have a trick question for you: what error do you think Excel 
will give you when you divide Michael by zero? #VALUE! or #DIV/0!? 

#N/A Error 

This is the error you get when you do a lookup function (VLOOKUP, 
LOOKUP, MATCH etc.) and Excel can't find what you are looking for. 
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####### Error 

You get this error for two reasons. The first and more common one is 
when there is not enough space in your Excel cell to display a 
numeric (number) value. Excel doesn't want you to take 1,000,000 as 
1,000 because space was only enough to show 1,000. So it puts in 
####### in the entire cell and force you to expand/widen the cell to 
see the entire content. 
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The second and less common one is when you do a calculation on 
date and the resulting date answer is too large or too small a value to 
be shown as a valid date in Excel. Here's what I mean. In Excel you 
can do 26-Aug-16 + 1 and you will get 27-Aug-16 (the next date). 

But when you try 26-Aug-16 + 999999999 you get ######## and no 
amount of expanding the cell will make the error go away. You are 
trying to calculate a post-apocalyptic date. 
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#NAME? Error 

This is the error you get when you type a formula name that doesn't 
exist in Excel. Maybe you wanted to type SUM but mistakenly typed 
SUN. Well, Excel doesn't know about the solar system so t will tell 
you that it doesn't recognize that formula name. 
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#REF! Error 

This is a very popular and troublesome error. It happens when you 
have a formula that picks value from a different sheet or different 
file and somehow the file or sheet becomes inaccessible (or deleted). 
When Excel tries to recalculate the formula, it gives you that #REF! 
error because it can't access one of the reference file/sheet. 
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A funny case that causes it is when you drag a formula that depends 
on a cell above it too way up that it messes with Excel's cell 
reference system. 
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#NUM! Error 

This is the error you get when you do a calculation that is too large or 
too small for Excel to handle. An example is 999 raised to the power 
of 99999 
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#NULL! Error 

This is a very uncommon error. We are all familiar with the 
multiplication, addition, subtraction, division etc. operations. There 
is one not very commonly known -- the intersect operator. And it is 
simply a space. It gets you the intersect value of two different 
ranges. 
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So what happens when you select ranges that do not intersect? You 
get #NULL! error. 



 

59 
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And those are the errors in Excel and their interpretation. Now you 
know what they are telling you anytime you come across them. 
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Data Cleaning 

 
A lot of times the data you are given to work on in Excel is not in a 
format usable for you and need some cleaning before you can go 
ahead with the analysis you intended doing on it. In most cases you 
have to manually clean the data and fix whatever issues it has one by 
one before progressing with the original analysis you intended to do 
on the data. 
 
Fortunately, Excel has some nifty tools to help you automate some of 
this data cleaning process. The most common ones are, 

● Removing duplicates, and 

● Text to Columns 
Then we’ll cover a special tool that can help you do a quick 
categorization of your data: Subtotal. Finally we’ll cover Data 
Validation, an ingenious tool for reducing data entry errors in your 
Excel files. 
 

Removing Duplicates. 
 
Occasionally, you will have a table and you’ll want to remove 
duplicate entries. If it were a sales transaction table, you might want 
to remove the duplicate sales entries. In the example below, it is a 
table of items (Pizzas) and we want to remove the duplicate entries 
leaving only unique entries. 
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As illustrated above, you select the entire records first and then go to 
Data menu, click on Remove Duplicates. You will get a confirmatory 
dialog box. Click on OK. 
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You’ll see a result showing the number of duplicate values that were 
found and the number of unique values found. Basically, what 
Remove Duplicates does is it leaves one record of each item and 
removes all the extra record for that item that it finds.  
 

 
 
When you select a table with more than one field entry, the Remove 
Duplicates remove only the entries that have same value in all the 
fields as a previous entry except you specify which fields to exclude 
in the search for duplicates. 
 
In the screenshot below, we excluded Car Sales from the fields to 
include in the search for duplicates. So rows that have the same 
entries in all the other fields will be deleted except one. 
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Text to Columns 

 
There will be times you will have data you would prefer split across 
multiple columns squeezed into one column. This happens a lot when 
you copy data from an external source into Excel or you open an 
exported data from other business software like CRMs and ERPs. 
 
Excel’s Text to Columns tool is the magic tool for splitting such data 
entries into multiple columns provided there is a recognizable 
character separating each field or they have fixed lengths per field. 
Below is a simple example for splitting a full name in one column to 
first Name column and last Name field column. 
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Delimited is the option to specify that there is a recognizable 
character separating each field. In this example, there is a space 
separating every first name from the last name. 
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Notice how Excel shows a line between the first names and the last 
names once you select the appropriate delimiter (space, in this 
case). Click on Next and Finish. 
 

 
 
Below is the result. Just as desired. 
 



 

67 

 

 
 
 

Subtotal 
 
Subtotal is a secret tool for doing a quick analysis of a table in Excel. 
It breaks the data down by categories and creates grouping that 
shows you different levels of details. 
 
It is also very easy to use. 
 
Below is an example where we’ll use it. 
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It is a market research data table showing the different car make sold 
in three different auto dealerships. 
 
We can apply a subtotal to this to see some interesting analysis. 
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Select the table, go to Data menu and click on Subtotal. In the dialog 
box that comes up, in the “Add subtotal to” section tick all the fields 
that have numeric values (except you don’t want to see a numeric 
analysis of them). 
 
Once you click on OK, you get a result that looks like the following — 
 

 
 
Level 1: 
 



 

 
 

70 

 
 
Level 2: 
 

 
 
Level 3: 
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And the best part is that you can remove the subtotal and have your 
original table data back just as it was before. To remove is as easy as 
clicking the Subtotal again and clicking on Remove All. 
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See the result below. All the level 1, 2 & 3 groupings gone. 
 

 
 
 

Data Validation 

 
This is another secret but powerful tool in Excel. It helps you put in 
place some error check mechanism and can be used by a skilled Excel 
user to make powerful Excel dashboards. 
 
Let’s see some of the common uses of it. 
 
The table below is an Employee records table. In it we want to force 
people to enter just departments specified at the left of the table. In 
fact, we want them to have the easy option of seeing a pre-
populated dropdown list and pick a department from the list options. 
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We select the cells we want to give this functionality, go to Data 
menu and click on Data Validation (sometimes twice). 
 

 
 
You’ll see that there are many options to pick between. 
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1. Any Value. This is the default and it is same as not having 
any data validation. The user can enter any value into the cell. 

2. Whole Number. This forces the user to enter only numeric 
values that are whole numbers. If the user enters a text or decimal 
entry he’ll get an error. This might be applicable in an invoice sheet, 
for the cells that hold the order quantity if you don’t sell fraction of 
your products. 

3. Decimal. This forces the user to enter a whole number or 
decimal entry. A whole number is same as a decimal with zeros after 
the decimal point. This might be great in a financial model sheet, to 
hold values of growth assumption, exchange rates and risk premiums. 

4. List. This is the one we are most interested in. It enables us 
to limit the cell entries to a list of options. We will use this in the 
example under review. 

5. Date. This forces the user to enter a valid date entry. 

6. Time. This forces the user to enter a valid time entry. 

7. Text Length. This allows the user to enter any value as long 
as the character length is not more than the specified value here. It 
is good for fields that hold phone numbers, maybe you want to limit 
the entry to the +2348123456789 14 characters long entry format. 

8. Custom. Just as the name specifies, you want to limit the 
cell entry to something less conventional and not covered by the 
other options. 
 
In this example we are going to use the List option. So let’s select it. 
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Once you click the icon on the far right corner of the Source box, 
select entries to limit the users to. In this case we have typed out the 
list options in cells G2:G6, holding the different departments. 
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And it’s done. 
 
The user is forced to choose between the options in the list. He even 
sees a dropdown arrow that expands to a dropdown lists the moment 
he tries to fill the cell. 
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And that is how Data Validation works. When used creatively it can 
save you from the stress of making corrections to forms people filled 
and can be used in conjunction with formulas like VLOOKUP to make 
a dynamic report and dashboards. 
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Data Formatting 

 
There are some quick tips in Excel that would turn a bland looking 
data into a nice looking one. One of the best tip is to apply a table 
formatting to the data. 
 
An example, is taking a table like the one below and turning it in a 
well formatted one. 
 

 
 
Select the data and go to Home menu, Format as Table. Choose a 
color theme. 
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If you want to email the Excel file to a colleague, you can copy the 
table and paste in Outlook and you’ll have the beautiful looking table 
in the body of the email. Your colleague will have no excuse to give 
regarding not seeing or acting on the data. 
 

 
 
 
So what if you needed to print it for your boss. 
 
Here’s what you get from Print Preview. 



 

 
 

80 
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So how can you make Excel print this table on just on paper? 
Very Easy. 
 
Go to Page Layout menu, and under the Scale to Fit section, set the 
Width and Height to 1 page. 
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So let’s see the result. 
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Goal achieved! But it could have looked better if it had used more 
space, the space below. So we need to try out one more setting and 
see if it will give us a better result. We will set the Orientation to 
Landscape. 
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Let’s view the result. 
 

 
 
Bravo! This is much better! 
 



 

85 

 

What if the boss wanted just January to May data and not the entire 
table? 
Also very easy.  
 
Highlight the table from the beginning up to May, leaving out June. 
So we are highlighting just what we want to print. 
 
Under same Page Layout, Click on Print Area, and select Set Print 
Area. 
 

 
 
And that’s it! So let’s see the result. 
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There we have it, no June data included! 
 
One more big tip.  
 
What if you have a big table that will print onto many pages but you 
want the header to repeat on the first row of every page? 
 
Below is a sample. 
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Notice that the page two has no header to help you identify what the 
fields are. 
 
So here’s how to fix that. 
 
Still at Page Layout menu, click on the small icon at the bottom right 
corner of the Sheet Options section. 
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In the dialog box that comes up, set the Rows to repeat at top 
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Select Row 1 that has the headers. 
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And that is all! 
 
So let’s see the result. 
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Done. 
 
So these are the basic ways you format your data for printing. 
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Custom Lists 

If you are an average or above average Excel user, you will be very 
familiar with Excel autofill. A common example is you typing numbers 
1 and 2, then dragging to have Excel do to 10 for you. Or having 
January and February, then dragging to have Excel do the other 
months of the year for you. 

What if I tell you that you can create your own list. A list of states in 
Nigeria which you can autofill whenever you need to recreate them. 
Or a list of your products; you simply type the first two and drag to 
create the rest (autofill). It even helps you with sorting in the order 
you've created the list. This can be super useful for companies that 
use codes for aspects of their operations -- base station address code, 
branch code, product code and so on. Caution: The custom list has a 
quite limiting size limit.  

So here is the example of how I created a custom list of states in 
Nigeria, arranged alphabetical order. 

First, I have the states typed out in Excel, in the order I want it 
(alphabetical order). 
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And we are half-way done to having it permanently in Excel as an 
autofill-able list. 

Go to File, Options, Advanced, and Edit Custom Lists. 
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In the Custom List Dialog box that comes up, import the list of states 
you already have typed into Excel. 
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And you are done. 

Now in a new Excel file or Sheet, type in the first two states, select 
them and drag down. Excel will start autofilling the other states. 
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Congrats! Now you've created a custom list. No more typing out 
states in Nigeria, just type the first (or first two) and have Excel 
autofill the rest for you. 
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Charts 

 
Excel 2010 has 11 main chart types. 
 

 
 
Excel 2013 and Excel 2016 have 10 main chart types. Actually, 9 If 
you take combo chart as a combination of two or more other chart 
types. 
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But in all you will end up using majorly, 

1. Column chart 

2. Line chart 

3. Pie chart, and 

4. Bar chart. 
 
So let’s focus on these four charts. 
 

Column Chart and when to use it. 
Column chart is used to visualize data across different categories. An 
example is revenue across the four different branches of a company. 
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So how do you turn a boring data like this: 
 

 
 
Into a beautiful insightful chart like this: 
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It is very easy. 
 
Select the table data you want to make a chart of and go to the 
Insert menu, click on the Column chart and select the 2D Clustered 
Column chart (the first option). 
 

 
 
You will get a chart that looks like the one below. Not bad looking, 
just needs a little formatting to make great. 
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Click on the chart, and the context based menus will show up on the 
Excel menu bar. 
 

 
 
 
Go to the Format menu and choose a formatting you like for the 
entire chart. If your company’s corporate color is red and purple, you 
might want to make charts that reflect that brand color. 
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See the result red border white fill format. 
 

 
 
You can also change the chart background color. 
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Also you can change the color of the bars by clicking on them and 
choosing the color you want. 
 

 
 
And this is the final result. 
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It looks better than the default and reflects your company’s 
corporate color. Just that you might want to not use the red border. 
Most professionals argue that it’s best to not use any border or 
background, just make only the important things obvious – data bar 
and the axis label. I suggest you do whatever looks great to you. This 
is not an exam and most likely what will look good to you will look 
good to your colleagues whom you’ll share the report and charts 
with. 
 
If you try out other color schemes you can end up with charts looking 
like the one below. 
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The extra step we took besides removing the red border and changing 
the bar color to bright blue is to change the chart area background to 
white. 
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And that’s basically how you insert and format a column chart. You 
can try inserting a 3D chart too for the same data. Follow the same 
steps but choose a 3D chart instead of the 2D we earlier used. And 
when you do the extra formatting already explained to you, you can 
end up with a beautiful chart like the one below. 
 

 
 
 
Finally, you can insert other elements on the chart like the data 
table, as shown below. 
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The result is shown below. 
 

 
 
You would have noticed that there are other column chart types 
besides the Clustered one we selected (the first option). 
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As numbered in the image above, they are 

1. Clustered Column 

2. Stacked Column 

3. 100% Stacked Column 
 
The clustered column is what we have used so far. It’s 
straightforward to understand. The stacked column is useful for 
showing the breakdown of the data that makes up the bar. Below is 
an example of its use. We are going to breakdown the revenue by the 
products that contributed to it. 
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To do this stacked column chart, you simply select the entire table 
data, including the breakdown by products and choose the Stacked 
Column chart. And as you can see, it shows a breakdown of each bar 
by the constituting parts (products in this example) 
 
The third one, 100% stacked column, is just slightly different. Rather 
than show you the breakdown by product revenue values, it shows 
the breakdown by the percentage contribution each product makes 
to the total. Below is the 100% Stacked Column output for the same 
data. 
 

 
 
 

 Line Chart and when to use it. 
 
Line chart is used to show trend, usually over a time period. An 
example is if you want to show the trend of how the company’s 
revenue has been growing for the last five years. 
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You create a line chart of a table in a similar way as we did for the 
column chart. You select the table’s data and go to insert menu, 
click on the Line chart type you prefer. 
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Again, Excel does a fairly good job and you can easily improve the 
format of the chart using the steps already explained. 
 

 
 
 

Pie Chart and when to use it. 
 
Pie chart is used to show the contribution of each category to the pie 
that represents the grand total. 
 
Below is an example showing the breakdown of Nigerian population 
by region. You can see how the Pie Chart makes it easy to see the 
contribution of each region to the total population of Nigeria. 
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It is extremely easy to make. You, like for others, select the table’s 
data and select Pie Chart under the Insert menu. 
 

 
 
Excel does a default pie chart that you can greatly improve. 
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Bar Chart and when to use it. 
Bar chart is technically the same as Column chart. The difference is 
that when you have a table with lots of entries, usually over 8, you 
are better off with using a bar chart rather than the column chart. 
Also when the entries have long label names, it’s better to use bar 
chart even if the entries aren’t many. 
 
Below is an example. 
 

 
 
The same rules about Stacked and 100% stacked apply to bar chart 
and, even, line charts. 
 

Combo Chart 
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Occasionally, you will have to combine two or more chart types in 
one visualization/graph. This is very useful if you want to show two 
interconnected data and their combined relevance. 
 
An example is showing how a company’s revenue has been changing 
in values and as a growth ratio.  
 

 
 
In Excel 2013 and Excel 2016, it is very easy to make. 
 
Just select the entire table and insert a combo chart. It can be easily 
located under Recommended Charts. 
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New Excel 2016 Charts 

If you've felt limited by the charts in Excel or would like to do some 
of those amazing charts you see online, then you've got to try out the 
new charts in Excel 2016. And if you are in finance and always had to 
use a complicated way to create waterfall charts, well, those hard 
days are now over. Same also for our statistically inclined folks -- you 
can now create your histogram and Box & Whisker charts easily in 
Excel. 

I will be showing you what those charts look like in Excel. And if you 
are impressed enough to want try them, all you need is Excel 2016. 
Better if you have the O365 subscription pack one, I think those ones 
get pushed new updates first. 

 
1. Treemap. 
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This lets you use rectangular bars of varying height and width to 
visualize performance or values of different entities. 

 
2. Sunburst 

 

It's a lot like Pie chart and Doughnut chart, main difference is that it 
automatically sorts the data to be visually represented in descending 
order clockwise and shows multi-level (hierarchy). 
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3. Histogram 

 

 

 
It is for showing frequency distribution. Those of us with some 
statistical background will be at home with it. 

 
4. Box & Whisker 
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This is also a statistician's tool. It is for showing the spread of values 
for the different quartiles in the data. 

 
5. Waterfall. 

 
 
This is an accountant's staple. It shows incremental effect of 
connected data points. 



 

125 

 

 
6. Funnel  

 

 
If you are into sales you will be familiar with funnels. How many 
leads you need to get a sale? Conversion rates? With a funnel chart 
you can visually depict each level of your sales activities and their 
conversion rates. 

And those are the new chart types in Excel. 

You can access them natively from the chart menu. 
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PivotTable and PivotChart 

 
PivotTable is Excel’s premium tool for working with huge data table 
and even data stored in other database systems like Access, SQL 
servers and MySQL servers. 
 
Below is an example of a large data table we will use PivotTable on 
to do some very relevant quick analysis. It is a table of sales for a 
particular Pizza Restaurant for a day and it has 5000 entries. 
 

 
 
So how can we make a report that will show us the sales performance 
that day by the different type of Pizzas the restaurant sells.  A report 
like the one below: 
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It’s quite easy with Pivot Table. 
 
You start by selecting the sales transaction table or selecting one of 
the cells in it. Then go to Insert menu and click on Pivot Table. 
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In the screenshot above, I selected one of the cells in the table, 
clicked on Insert menu, clicked on PivotTable, confirmed that my 
entire table has been selected and clicked on OK. 
 
You will be taken to a new sheet that looks like the one below: 
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At first it looks really different, like you are no longer in Excel. But it 
is very easy to work with. The core part is the part on the right with 
the name PivotTable Fields. It has a list of all the fields in the 
original data table. The part below the field names are where you 
actually set up your report. 
 
Whatever field you want to display its unique entries, one per 
line/row, you will drag to ROWS. Let’s do that for the Pizza Sold field 
so we will be able to see all the pizza types the restaurant sells. 
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Then if it is that you want to display those unique entries one per 
column, drag the field to COLUMNS. Let’s see what will happen if we 
drag that Pizza Sold field from ROWS to COLUMNS. 
 

 
 
So now you understand how ROWS and COLUMNS work.  
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Drag Pizza Sold back to ROWS, that is where we need it for our quick 
analysis. 
 
Next is VALUES. Whatever you want to do a mathematical calculation 
on, you drag to the VALUES part. Common calculations you will find 
yourself doing are counts (to see the number of time each unique 
entry occurred in the original table), sum (to add the values a 
particular field) and average (to average the values of a particular 
field). 
 
In our case, let’s drag Quantity and Amount Sold fields to VALUES. 
 

 
 
Can you see how quick this is? We have just analyzed a 5000 sales 
record table in seconds. Now we have a report that shows us how 
many of each Pizza type was sold and the total sales amount 
generated. 
 
Those are the type of lightning fast analysis PivotTable allows you to 
do. 
 
There is now one part we haven’t touched: FILTERS. As the name 
suggests, it simply gives us the capability to filter our report. We will 
drag Time Range to FILTERS to see which sales occurred at the peak 
period (before 9:00am) and after the peak period. 
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And that’s how PivotTable works. Very easy to use and powerful. 
 

PivotChart 
 

Whenever you insert a chart using data generated via a PivotTable, 
that chart is a PivotChart. It has some extra functionalities it inherits 
from the PivotTable which makes it a little different from the regular 
charts we have already discussed. 
 
Below is the PivotChart for the PivotTable we just created. 
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Notice the extra elements on it. Even the Time Range filter is 
showing on the chart. Besides those extra elements, a PivotChart is 
same as the regular charts and the same kind of formatting you can 
do on the regular charts work on PivotCharts. 
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Business Data Analysis 

 
When using Excel to organize or analyze your business operations 
data, there are some tools you need to be aware of. 
 

Linking Sheets 

  
You often have to pull data into a report from another report or Excel 
file, the most effective way to do this is to link the sheets. You will 
be mirroring the value in the source sheet in your destination sheet.  
 
An example is if there is a sheet that contains the internal revenue of 
all the states in Nigeria and you are doing a report on Kebbi state. 
You want to pull the values for Kebbi state from the sheet that has 
everything (source sheet), your best bet is to link the sheets. It is 
preferable to copying the values from the source sheet because if the 
source sheet is updated with new values your analysis sheet will not 
automatically update (will still be showing the now incorrect old 
values). So how do you link sheets? 
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It’s very easy. In the fields in the analysis sheet, for the different 
months values you will type = and select the cell with the actual 
figure in the source sheet. 
 
In the end you will have the following or similar: 
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The source sheet has the name Datasheet, hence the 
=Datasheet!B25 in January value cell in the analysis sheet. You don’t 
type anything beyond = into the values cells in the analysis sheet, 
once you select the right cell in the source sheet, Excel will write 
everything you see in the cell. 
 

Duplicating Sheets 

 
Sometimes you will want an exact copy of a sheet to work with or 
email to someone (especially if the Excel file contains other sheets 
you don’t want the person to access). Excel has a nifty tool for 
duplicating sheets. And it’s very easy to use. 
 
Right click on the name of the sheet you want to duplicate. Click on 
Move or Copy… 
 

 
 
You’ll see a dialog box. Select new book and tick Create a Copy. 
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And the sheet will be duplicated in a new Excel file for you. 
 

 
 
 

Inserting Sheets, Renaming Sheets and Changing Sheet 
Tab color 

 
You can insert a new Sheet in an Excel file. Just click on the new 
sheet icon at the right of the last sheet tab in the file. 
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You can also rename the new Sheet to what you want. Just right click 
on the sheet tab and select Rename. 
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Finally, you can give it the color you want. Again, right click on the 
sheet name and click on Tab Color. Choose the color you want. 
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Freezing Panes 

 
There will be times you have a table to with lots of entries and will 
require a lot scrolling up and down, and even left and right. Often 
you will want some part of the table to never scroll out of view. This 
is usually the headers. Achieving this requires enabling a tool called 
Freeze Panes. 
 
It freezes the part of your report you don’t want to scroll out of 
view. Below is an example. You access it from the View menu. 
 

 
 
There are three options: 
1. Freeze Panes. To use this option you have to select a cell in the 
table. This option will freeze all the rows above the cell you selected 
and all the columns to the left of the cell you selected. So you have 
to select just the right cell. If you want to freeze rows 1 and 2, then 
you will select cell A3. 
2. Freeze Top Row. This freezes the top row in your Excel’s current 
view. 
3. Freeze First Column. This freezes the first column in your Excel’s 
current view. 
 
Below is the result of freezing row 1. It doesn’t scroll out of view 
even when I scroll way down. 
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Splitting Windows 

 
Excel lets you split your current Excel view into two independent 
windows that you can scroll separately. This is useful if you want to 
monitor changes in two different far away parts of your Excel file 
that are dependent. 
 
An example is shown below. The Excel file is a stock analysis file and 
at the top far right are projected values based on assumptions made 
far down the Excel sheet. So in order to see instantaneously the 
effect of a change in an assumption on the projected values, splitting 
window was used. 
 

 
 
And the assumptions far down 
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Splitting window allows us to view this two far away parts of the 
Excel sheet at once. 
 
To do this, select the middle row in the Excel sheet and go to View 
menu and click on Split. 
 

 
 
Then scroll the section below the splitting point down to the 
assumptions part. It will scroll independent of the part above the 
split line. 
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Notice the jump from row 10 to row 104.  
 
Now whenever you alter the assumptions you won’t have to scroll up 
to see the effect on the projected revenue and projected profit. 
 

Conditional Formatting 

 
Conditional formatting is another power tool in the power Excel 
user’s toolbox. It allows you to indicate the relative performance of 
metrics (KPIs). Below is a simple example of its use. 
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Notice the green, yellow and red arrows. They are conditional 
formats that let you visually see where you are spending below your 
budget, where you are spending exactly what you budgeted and 
where you are spending above your budget. 
 
Those are type of practical visual analysis conditional formatting 
provides. 
 
You can access it via the Home menu. And it has the following 
formatting groups. 
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Excel 2016 Forecast Tool 
 
There is a forecast tool in Excel 2016. It helps you make time series 
forecast. 
To show you how it works, I have prepared a sample sales data. 
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It is the daily sales record of a grocery store for this year.  The store 
has been hit by the current economic downturn and sales are not as 
good as they used to be. The owner is very worried and wants to see 
what the future will be like if the trend continues. 
 

 
 
This is what the forecast tool in Excel 2016 is built for. And here's 
how to use it. 
 
Select the historical data, go to Data menu and select "Forecast 
Sheet". 
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The forecast dialog box comes up. Set the date you want the forecast 
to end (Forecast End). 
 

 
 
If you are familiar with time series, it is a triple exponential 
smoothing capable time series tool. You can expand the options and 
set things as you want. 
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And for the setting above (default setting), here is the result. 
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Now the store owner can see that things will get worse if he doesn't 
do something to halt the downward sales trend. And that is how easy 
it is to run a time series forecast in Excel 2016. Unfortunately, it is 
not available in Excel 2013, Excel 2010, Excel 2007 and, obviously, 
older Excel versions. 
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Power Excel Formulas 

 
Excel has thousands of formulas but a select few stand out as very 
versatile and useful for day to day business data analysis and 
reporting. We are going to focus on those formulas in this section. 

 
VLOOKUP 

 
This is perhaps Excel’s most popular function. In interviews it is used 
to sieve the power Excel users from the occasional Excel user. Its 
popularity lies in its ease of use and capability to get you the data 
you need from another table if you provide it a clue.  
 
Below is an example of its use. 
 

 
 
The formula breakdown is  
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Lookup_value 
=VLOOKUP(A2,A5:G24,2,FALSE) 
Basically, it is asking you for the clue you have. What piece of 
information do you have that I should look for in the table that has 
everything. 
 
Table_array 
=VLOOKUP(A2,A5:G24,2,FALSE) 
Where is the table that has everything? So here you are selecting the 
table that has everything. 
 
Col_index_num 
=VLOOKUP(A2,A5:G24,2,FALSE) 
When I see the clue, what data should I bring back? That data is in 
what column counting from the leftmost column in the selected 
table. 
 
Range_lookup 
=VLOOKUP(A2,A5:G24,2,FALSE) 
If I am unable to find the clue, should I take a guess? Usually, you 
wouldn’t want Excel to take a guess, that could cause you trouble. So 
say no by typing FALSE. 
 
And that is how VLOOKUP works. It will look through the first column 
in the table you selected for the clue that you provided and when it 
finds it, it will bring back the data you specified for it to get. 
 
It makes a lot of reports easy to do and very helpful with making 
dashboards. 
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IF 

 
IF is arguably the most powerful function in Excel. It can do almost 
the impossible. And it’s only limited by the creativity of the user. 
It allows you to check for a condition and specify what should be 
done when the condition is met and also what should be done when it 
is not met. 
 
Here is the structure. 
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In the example above, we have specified a condition that only when 
the salesman makes more than 1 million naira worth of sales should 
he get the sales bonus of 5%. If he fails to meet that condition he is 
not entitled to any sales bonus. 
 

COUNTIFS and SUMIFS 
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These combine an inbuilt if function with simple functions like count 
and sum.  
 
A relevant example is the Pizza Sales record we used for PivotTable. 
We could have generated the same analysis without PivotTable by 
using the COUNTIFS and SUMIFS functions. 
 

 
 
For the Count of Sales, the COUNTIFS structure is 
 

 
 
This will count cells between range B1 and B5001 where the cell 
entry is equal to the G3 value (BBQ Chicken). And it was replicated 
for the other pizza types. 
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For the Sum Of Sales Amount, the SUMIFS structure is 
 

 
 
It will sum values in cells C1 to C5001 where the cells in B1 to B5001 
has cell entry equal to G3 (BBQ Chicken).  
 

AVERAGEIFS 

AVERAGEIFS is similar to SUMIFS. Generally, I think it is much less 
used than SUMIFS. In my several consulting jobs for clients I have 
used more of COUNTIFS and SUMIFS than AVERAGEIFS. It is 
particularly useful in performance analysis. An example is if you are a 
stock analyst and you want to find the profit margin for a particular 
industry. You will need to use AVERAGEIFS to specify which 
companies to include in the computation of the profit margin, and 
statistically, you can’t count or sum the individual profit margins, you 
have to average them. 

 

Below is an example we’ll use for illustration. 
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So how do we find the profit margin performance for the Airline 
Industry? We have to use AVERAGEIFS. 

 

Here is how it works: =AVERAGEIFS(average_range, criteria_range, 
criteria) 

 

The average range in our case is the Profit Margin field. That is where 
the profit margin values we want to average are.  

The criteria range is the Industry field. It is where we will identify 
the companies that fall under the airline industry. 
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The criterion we are looking for is Airline. But remember to put it in 
double quotes. All texts in a formula must be in double quotes. 

 

The resulting formula will be: =AVERAGEIFS(C1:C22,B1:B22,"Airline") 

 

 

 

IFERROR 

A lot of times your formulas in Excel will generate an error. It could 
be for reasons beyond your control: a missing record, wrong value 
type or a problematic entry. IFERROR lets you trap errors and display 
something more meaningful or less annoying than the cryptic error 
entry Excel gives you. 

 

Its syntax is: =IFERROR(value, value_if_error) 

 

An example to illustrate its use is given below. 
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Notice that we have no value for Enugu state and it is generating an 
error in the %age value field. It would be nicer to have left a blank 
space or a hyphen instead of an error code in the Enugu row. 

 

IFERROR can help us with that. And here is how we would do it. 
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=IFERROR(B5/$B$9,"-") which is simply telling Excel to calculate 
B5/$B$9 and if the result is an error it should put a hyphen in the cell 
instead of an error code. 

 

CONCATENATE 

Concatenate lets you join entries in different cells.  

 

The syntax is =CONCATENATE(text1, text2, …) 

 

A clear example is what we have below. 
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How do we join the First Name and Last Name to get the Full Name? 

This is what CONCATENATE does for us. 
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But there is a small problem: no space between the first name and 
the last name. How do we fix this?  

 

CONCATENATE can handle that. You are not restricted to joining cell 
entries. You can put in your own text and that’s what we will do to 
fix the problem we have.  
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We have added a space between the first name and the last name. 
We added it as a text entry, hence the double quotes encapsulating 
it. 

=CONCATENATE(A2," ",B2) 

 

 

 

And that’s how you can join different cell entries using 
CONCATENATE. 

 

I’m sure you are wondering why the formula had to be a long name 
one. Well, there is a very short alternative operator: &. 

We can simply join the different cell entries by putting an ampersand 
(&) between the entries. So replacing our long formula, we will have: 
=A3&" "&B3 
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Great, right? 

 

All that is left is to drag the formula down for the other entries. 
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LEFT, RIGHT and MID 

There will be times you need to extract a portion of a cell’s entry. A 
practical case was a template I built for a telecoms company to 
determine the least cost partner to use for each international call 
destination. So I had to use a formula to pick out the country codes 
and check which provider is the cheapest to use to that destination.  
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I have prepared a sample data for a simple illustration. It is the 
matriculation number of the university I attended. It is a clever 
combination of department name, year of admission and candidate 
number. 

 

 

 

The first three characters are the department acronym. The two 
digits sandwiched between two forward slashes are the year of 
admission and the last four characters are the candidate number. 

 

We are going to use LEFT to extract the department name, RIGHT to 
extract the candidate number and MID to extract the admission year. 
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It is a very easy to understand formula: =LEFT(A5,3). You simply 
specify the cell you want to extract from and specify the number of 
characters you want to extract starting from the leftmost character. 

In this example, it’s three characters we want to extract starting 
from the left (beginning of the cell entry). 

 

Now let’s proceed to extracting the candidate number. This time we 
want to extract starting from the right, four characters. So we will 
use RIGHT. 

 

 

 



 

 
 

170 

 

 

=RIGHT(A5,4) 

Also very easy to understand. 

 

Finally, let’s extract the admission year. It requires the MID formula. 
It’s a little not easy to grasp like the LEFT and RIGHT. It requires that 
you specify the starting point for the extraction. The concept is very 
easy to understand, the part that trips a lot of people up is how the 
starting point is determined. You have to count from the first 
character (from the left) to the first character you want to extract.  

 

In this example, we will count till the first character of the year. It is 
the character number 5. Then you’ll proceed to specify the number 
of characters you want to extract (2 in our case).  
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=MID(A5,5,2) 

A5 is the cell we are extracting from.  

5 is the starting point. 

2 is the number of characters we want to extract. 

 

TODAY, DAY, MONTH and YEAR 

Excel allows you to do a lot on dates. There is even a formula to call 
up today’s date; it is aptly named TODAY(). You have to enter the 
brackets. 
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Then you can extract the day of the date, the month of the date and 
the year of the date very easily. 
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=DAY(A3) 

=MONTH(A3) 

=YEAR(A3) 

A3 is the cell that has the date. And it works on dates you manually 
type or copy into Excel and not just the ones we use a formula like 
TODAY() to generate. 

 

Finally, Excel lets you choose how a date should be displayed. Right 
click on the cell housing the date and click on Format Cells. 
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You can specify how it should be displayed. 

 

UPPER, LOWER and PROPER 

Ever tried changing a text from upper case to lower case in Excel? 
Too quickly people give up and conclude that it’s not possible in 
Excel. Well, Excel has that functionality but as a formula. 

 

UPPER converts a cell entry to all upper case. 

LOWER converts a cell entry to all lower case. 

Proper capitalizes the first letter of each word in the cell. 
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A1 is the cell entry we want to change the caps of. 

See the results of the UPPER, LOWER and PROPER formulas below. 

 

 

 

 

RAND and RANDBETWEEN 
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Wondered how I generated all the data I have been using for 
illustrations? Well, I used RAND and RANDBETWEEN for most of the 
numbers and even some of the texts (in conjunction with a magic 
formula called INDIRECT). 

 

RAND() generates random decimal numbers that are greater than 0 
but less than 1. Essentially, decimal numbers between 0 and 1 (0 and 
1 non-included). 

 

RANDBETWEEN(bottom_number, top_number) generates numbers 
between the bounds you specified as bottom and top. 

 

Below is a relevant example. I have used the formulas to generate 
sales number and profit margin. 
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CHOOSE 

CHOOSE is one of the formulas dedicated to making your analysis life 
easier. You can easily do dynamic reports just by using CHOOSE. 

I have an illustration we can all easily understand. It is Sam's todo list 
for the day. A list of 10 tasks he has arranged in the order he intends 
to carry them out today. 
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In reality, you would want to use CHOOSE for something more 
complex. But the concept is the same and once you grasp how to use 
it here, you can use it anywhere -- even for a list of 100,000 entries 
in a different Excel file. 

Back to our illustration. Sam wants a simple way to see the progress 
he is making. He wants to type in a task number and see what it is 
about and if he has done it. And this where CHOOSE comes in very 
handy. 

The way CHOOSE works is you specify the position of an item you 
want to pick and then the list of all the items. See below how Sam 
has used it to solve is problem. 
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CHOOSE checks for what number is in cell B3 and looks through the 
orderly list of Description field items, then returns the one that is in 
the position specified in cell B3. The one above should return "Call 
Customer XYZ" as that is what is in the position 1 in the Description 
field items. 

And below is a similar formula for the Remark. 
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Let's specify Task number 4. 

 

  

 

Let's specify Task number 8. 
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Another interesting use of CHOOSE is in a Financial Model to select 
different projections scenarios. And that’s it for choose. 

 

SUMPRODUCT 

SUMPRODUCT is one of Microsoft Excel’s magic tool. It is just as 
powerful as the user’s creativity (like the IF formula). I will start with 
a simple example to help you grasp how it works. 

Let’s say you own a grocery store and sell five product types. Every 
day you fill an Excel report template that already has the product 
names and prices. All you have to do is fill in the respective 
quantities bought and have the total sales for that day automatically 
computed for you. 

 

 

Ordinarily, you will have to compute the sales for each product by 
multiplying the price by quantity, and then sum them up to get the 
total sales. 
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However, with SUMPRODUCT you can get it done in one step without 
having to compute the sales of each product individually. 

You simply tell Excel to sum the products of Price and Quantity: 
SUMPRODUCT 
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Now you get how SUMPRODUCT works. Next, I will show you the more 
magical use of SUMPRODUCT 



 

 
 

186 

So let's say you manage a sales team and they sell two products. 
Every month, you get the report of the sales from each person which 
you combine to have a consolidated sales report. 

 

  

As part of your team building strategy and sales improving tactic, you 
do an in-depth monthly performance report of each sales person per 
product with recommendations of what they could have done better. 
And to make this report, you constantly find yourself picking the 
sales for a month for a product by each salesperson. Like a probe into 
each person's sales figures. So what if you want something that will 
help you automate part of that probing by showing you total sales by 
a particular sales person per specified product and specified month. 
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A formula that you can supply the person, the product and the 
month, and it will pick for you the total sales figure. Something like 
VLOOKUP except that VLOOKUP doesn't accept multiple lookup 
criteria and do a sum. So what formula would you use? 

The answer: SUMPRODUCT 
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Don't be put off by the length or complexity of the formula. It is easy 
to grasp. What I more importantly want you to pay attention to is 
that whenever you have a table and want to pick a value (numeric 
value and involving a summation) based on multiple criteria that 
VLOOKUP can't handle, then turn to SUMPRODUCT. 

 

And here is how the formula works: 
=SUMPRODUCT((A2:A13=K3)*(B2:B13=K4)*(C1:H1=K5)*(C2:H13)) 

(A2:A13=K3) checks for where the Sales Person field matches the 
name you provided in cell K3. Likewise, (B2:B13=K4) checks for 
where the Product field matches the product name provided in cell 
K4. And (C1:H1=K5) checks for where the month field has the month 
provided in cell K5. Finally, by multiplying them together and with 
the sales value range, (C2:H13), Excel will only pick values that 
match the criteria we have set-up and sum them up. 
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To make it clearer, here is the screenshot of what Evaluate Formula 
shows towards the last calculation step. Notice that only places that 
don’t match our conditions have zeros. 

 

 

 

 

 

And that’s the beauty of SUMPRODUCT. I find myself using it a lot for 
creating dashboards/templates where I am summing values that meet 
many conditions across rows and columns (like we have for product 
name across rows and month across columns) which SUMIFS cannot do 
(SUMMIFS can only work across rows or columns but not both at 
once). 
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SIX NEW USEFUL FORMULAS IN EXCEL 2016 

Microsoft added 6 new very useful functions to Microsoft Excel 2016. 
They are mainly based on Microsoft Excel user community requests. 
You too can request for any new function or tool in Excel via 
https://excel.uservoice.com/  

 

  

 

https://excel.uservoice.com/
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CONCAT 

Two complaints I hear people make a lot about CONCATENATE (the 
Excel function that lets you join the values/texts in different cells) 
are that why is the name that long? and can't we select a range? 
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Now Microsoft has nifty fixed those two issues in one cool function: 
CONCAT 

CONCAT is short to write and allows you join entries selected as a 
range. 

 

TEXTJOIN 

This takes CONCAT to a new level. So what if you want to put a 
comma and a space between the names as you are joining them? That 
is what TEXTJOIN enables you to do. 
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IFS 

The formula that gets most people confused the most in Excel is 
nested IF. People find it hard to process the numerous brackets and 
IF statements that characterize a nested IF function. Now there's 
some relief. Excel has introduced IFS to help combat the strain of 
untangling brackets. 
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If you have a report and need to grade the performance with some 
conditions like we do for school marks to grades, then IFS is your new 
friend. 

 

SWITCH 

So what if you want to pass a comment on the grade performance? 
You want to say grade A means Excellent, grade B means Very Good, 
and so on. Well, that is what SWITCH allows you to do. It was 
borrowed from the programming community. 
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MAXIFS 

And there is also MAXIFS to let you do want you've been doing with 
SUMIFS and COUNTIFS, just this time you are picking the highest 
value that meets your criteria. 

 

 

  

MINIFS 

And this is the sixth and last: MINIFS. You've guessed right! It does 
similar stuff as MAXIFS but returns the minimum value that meets 
your criteria. 
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Named Range, Goal Seek, Data Table 
and Scenario Manager 

Excel has some what-if-analysis tools that greatly help with business 
decision analysis. You can easily simulate effect of changes in 
circumstances on your business projections and create compelling 
business case analysis.  

 

Named Range 

Excel lets you name a cell or a selection of cells. It’s very useful 
when you are building models in Excel as it makes the model 
formulas easy to write and troubleshoot.  
 
They are two ways to create a named range and I will start with the 
very quick and easy way. 
 
Just select the cell or group of cells you want to name. Go to the 
name box and type in the name, replacing the cell address in the 
name box. 
 

 
 
 

 
 
We’ve successfully named all the Imo state revenue values as Imo. As 
benefit number 1, we can use it in a SUM formula instead of 
highlighting the entire range. 
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Another advantage will become obvious later when we do Scenario 
Manager. 
 
So what is the second way of creating a named range? 
 
It is, in fact, the standard way. It’s also the only way that allows you 
to edit an already created named range. 
 
Go to Formulas menu and click on the Name Manager. 
 

 
 
You can create new named range, edit already created ones and 
delete a named range. 
 

GOAL SEEK 

Goal seek is one of those powerful but seldom used tools in Excel. 
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It allows you to set-up a small model and tell Excel to optimize it for 
you based on one variable input and one set output. It’s the perfect 
introduction to a model and linear programming in Excel. 
 
Let’s a simple and common use case. Below is a loan calculation 
table. Let’s say I have found a huge business opportunity in large 
scale cocoa farming and I want to borrow N100 million from the bank. 
And the table below is the conditions the bank gave me: a payment 
period of 10 years and annual interest rate of 24%. 
 

 
 
 
Excel has a formula for calculating the annual payment amount. 
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So I go and check my business financial projection, and find out that I 
can only afford to make N20 million annual payment. What rate will I 
negotiate with the bank?  
 
This is where Goal Seek comes in. We simply tell it to find out what 
interest rate will evaluate to N20 million annual payment. 
 
To access Goal Seek, go to Data menu and What-If-Analysis. 
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I set payment amount cell to N20 million and tell Goal Seek to vary 
the interest rate. 
 
Once I click on OK, it does a series of iteration and gives me the 
result. 
 

 
 
 
I should ask for 15% annual interest rate. 



 

 
 

202 

 

Data Table 

Excel has an amazing tool called Data Table. It lets you sort of 
simulate a lot of predefined conditions. 
 

 
 
For illustration, I'll create an example we can all relate with. It's the 
revenue projections of a small vibrant company. 
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There is a formula in the Revenue field that depends on the Product 
Price and Marketing Cost. 
 
The next thing, we will do is help the management simulate what the 
Revenue will be for different combinations of Product Price and 
Marketing Cost. 
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This is the sort of task Data Table is great at. 
 
All we have to do is link the cell at the junction of the simulated 
Product Price and simulated Marketing Cost to the calculated 
Revenue cell. See the screenshot below for what I mean. 
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Now we are ready to use Data Table. 
 
Select the entire simulation table. 
 

 
 
Then go to Data menu, What-If Analysis and Data Table. 
 

 
 
In the small dialog box that comes up, set the Row Input Cell to the 
Marketing Cost value in the analysis table. And set the Column Input 
Cell to the Product Price in the analysis table. 
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And you get what the Revenue will be for the different combinations 
of Product Price and Marketing Cost. 
 

 
 
It's now left for the management of Vibrant Nigeria Limited to choose 
which combination of Product Price and Marketing Cost will get them 
the best Profit after factoring the Cost of Sales. 
 
And now you understand how Data Table works in Excel and when you 
might want to use it. 
 

Scenario Manager 

Scenario Manager is one of Excel’s decision analysis tool. It allows 
you compare outcome for different business scenarios. 
 
Below is a practical business use case of the scenario manager. It is 
taken from our business circumstance and you’ll find it very 
interesting. 
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We run a Microsoft Excel and Business Data Analysis business. Our 
major income streams are consulting for big multinational firms on 
data analysis and business process automations, and Microsoft Excel 
training. So let’s say we decide to run a special one day Microsoft 
Excel training. It was specifically my idea. I had stumbled on a 
training advert on Punch newspaper. A one day training at VCP Hotel 
and costing N80,000. So I felt we should try it too. But I needed to 
build a convincing business case for the idea. And in doing this I used 
scenario manager. 
 
I called up the hotel to get the details of the cost of hosting a full 
day training in their conference hall. I then went to work on the 
other costs that would be incurred in putting together the training. 
And below is the sheet of the cost details. 
 
 

 
 
And the underlying formulas are: 
 



 

 
 

208 

 
 
As you can see, I have gotten every cost item listed; the estimated 
number of participants and the course fee too. But to build a 
convincing business case I need to create different scenarios. Maybe 
three scenarios. 

 Scenario 1: The worst that could happen if we don’t market 
the training well and put the course fee enticingly low. 

 Scenario 2: The most likely thing to happen if we do our 
regular marketing and put up a fair course fee. 

 Scenario 3: What would happen if everything goes extremely 
well. Which will be our marketing aim. 
 
So how do you set up this scenarios in Excel? You use Scenario 
Manager. 
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But first we need to use Named Range for the most important cells in 
our scenario. They are the Gross Profit cell, the Number of 
Participants cell and the Course Fee cell. In our scenarios we want to 
monitor what the Gross Profit will be for different combinations of 
Number of Participants and Course Fee. 
 
I hope you remember how to do Named Range. You simply select the 
cell or range, go to the name box and type in the name you want to 
name the selection as. 
 

 
 
We do same for Course Fee. 
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And for Gross Profit. 
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Now, we launch the Scenario Manager. 
 
It is under Data Menu, What-If-Analysis.  
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So let’s add the three different scenarios. 
 
I’ll start with the worst. Click on Add and give the Scenario name as 
Worst. The cells we will vary are the Number of Participants and 
Course Fee cells. 
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Click on OK.  
It will ask you to set the number of participants and course fee. So 
based on experience, I know that if we do no serious marketing and 
set the price to N45,000 we can get 20 people. And that is the worst 
that can happen. 
 

 
 
Click on OK. 
 



 

 
 

214 

Create a second scenario. Name it “Probable”. It will be what we will 
most likely achieve. Give the number of participants as 30 and the 
cost as N70,000.  
 
Finally, do the last scenario. Name it “Ideal”. It will be our marketing 
aim if we decide to go ahead with the training idea. Give the number 
of participants as 40 and the cost as N100,000 
 
Once you are done, the Scenario Manager dialog box would look like 
the one below. 
 

 
 
 
Click on Summary. It will ask you for the Result cell to monitor. That 
is the Gross Profit cell. 
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Click on OK. 
 
You will be taken to a new sheet showing the comparison of the 
different scenarios. 
 

 
 
And as you can see, I now have a convincing case to show my partners 
and make them agree to organizing the one day training. 
 
That’s how easy and powerful the Scenario Manager is. 
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Introduction To Excel VBA (macros) 

 
A lot of people feel making macros in Excel is extremely hard and 
should be left only people who make a living from doing it full-time. 
If you are one of such people, I have a pleasant surprise for you. 
Macros in Excel are very easy and in the next five minutes I will guide 
you into making one. 
 
So just before we start, let me do a brief explanation of what a 
macro is, why you might need to make one and the benefits of being 
able to make one. 
 
Macros are simply a means of automating tasks in Excel. It’s no more 
than that. You might need to do it when you have a daily or weekly 
report you make that is of an unvarying standard format, input and 
output-wise. Having a macro can cut your analysis time from hours to 
15 seconds. It’s like magic and everyone in your office will see you as 
a special being. 
 
To be able to make macros, you need to make a small settings 
change in your Microsoft Excel. 
 
Go to Files, Options and Customize Ribbon. Check the box beside 
Developer. 
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Now you will be able to access the Developer menu. 
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Also enabling the Macro record button which we will use in this 
introduction to Excel VBA. 
 

 
 
 
Next, I will show you how to create a macro by clicking the right 
button twice — the macro record button. 
 
I have prepared a sample illustration data. 
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It is fictitious table of Sales at an Autodealership by the different 
salesmen and the car make. 
 
So the task I will use a macro to automate is a series of formatting 
steps.  
 
Note: For the gurus, it would be obvious that copy pasting format 
would have done the same thing our macro will do. Yes. But we have 
to do the illustration with something not too complex to confuse 
anyone. The good thing is that you will learn all the steps required to 
make any complex recorded macro you desire. 
 
So here are the easy steps to creating a macro. 
 
First, I select the month I want to manually do the formatting for and 
have the macro recorder save my steps. 
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Click on the macro record button. 
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Give the macro a name, a keyboard shortcut and a description. 
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Click on OK. 
 
Then begin doing the formatting steps. I change the font type, font 
color and add border, making it have our corporate color feel. Once I 
am done, I click on the stop recording button. 
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And that’s all. We have created a macro. Next is to try it out and see 
it work. 
 
Select another month’s record and press CTRL + k (the keyboard 
shortcut we used for the macro). 
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Voila! It works! 
 
So let’s insert a macro button. A button you will click to run the 
macro. I am sure you’ve seen one before. They are super easy to 
create. 
 
Go to the Developer menu, Insert and select Button under Form 
Controls. 
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Draw a rectangular button where you want the macro button to be. 
Immediately, Excel will ask you to select the macro to link it to. 
Select the macro we just created. 
 

 
 
Click on OK. 
 
Then edit the name of the rectangular button. 
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And that’s it! You’ve created a macro button. 
 
Now select another month’s data and click on the macro button to 
see it work the magic we configured it for. 
 

 
 
See the result! 
 

 
 
Amazing, isn’t it? 
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I hope you are now convinced that creating a macro in Excel is very 
easy. 
 
It’s now time for you to think up other creative ways to use a 
recorded macro. 
 
Bonne chance! 
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